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Safety Instructions

Safety Instructions e English

WARNING: This symbol, 4, when used on the product, is intended
to alert the user of the presence of uninsulated dangerous voltage
within the product’s enclosure that may present a risk of electric
shock.

ATTENTION: This symbol, &, when used on the product, is
intended to alert the user of important operating and maintenance
(servicing) instructions in the literature provided with the
equipment.

For information on safety guidelines, regulatory compliances, EMI/EMF
compatibility, accessibility, and related topics, see the Extron Safety and
Regulatory Compliance Guide, part number 68-290-01, on the Extron
website, www.extron.com.

Instructions de sécurité e Frangais

AVERTISSEMENT : Ce pictogramme, A, lorsqu'’il est utilisé sur
le produit, signale a I'utilisateur la présence a I'intérieur du boitier
du produit d’une tension électrique dangereuse susceptible de
provoquer un choc électrique.

ATTENTION : Ce pictogramme, A, lorsqu'il est utilisé sur le produit,
signale a I'utilisateur des instructions d'utilisation ou de maintenance
importantes qui se trouvent dans la documentation fournie avec le
matériel.

Pour en sav tion, la compatibilité EMI/EMF, I'accessibilité, et autres
sujets connexes, lisez les informations de sécurité et de conformité
Extron, réf. 68-290-01, sur le site Extron, www.extron.com.

Sicherheitsanweisungen ¢ Deutsch

WUHCTpYKUMS NO TexHuke
6e3onacHocTu ¢ Pycckuii

NPEAYNPEXAEHUE: [laHHbli cumBon, A, ecnu ykasaH
Ha nNpoaykTe, NpeaynpexaaeT nonb3osarens o
HaIM4Ynm HeM30NMPOBAHHOIO OMNACHOro HanpsXeHus
BHYTPY KOpnyca npoaykTa, KOTOpoe MOXEeT NPUBECTMN K
NOpPaxXeHUo 3NeKTPUYECKNM TOKOM.

BHUMAHME: [aHHbiii cumeon, A, ecnn ykasaH Ha
npoaykTe, npenynpexaaeT nons3osartess 0 Hann4iun
BaXHbIX MHCprKLLVII‘/'i no akcnayataumn v O6Cﬂy)KIABaHI/ﬂ0 B
PYKOBOACTBE, NPUNAraeMoMm K JaHHOMy 0G0PYA0BaHMIO.

Lnsa nonyyeHns nHGopMaumm o Npasunax TeXHNKN
6e30nacHOCTH, COBMIOAEHNN HOPMATHBHBIX TPe6OoBaHNIA,
aneKkTpomarHuTHol coemectTumocTu (SMMM/3MC), BO3MOXHOCTH
[ocTyna 1 Ipyrux BoNpocax CM. PyKOBOACTBO NO 6e30nacHoCTh
1 cobniofieHnio HopMaTuBHbIX TpebosaHuin Extron Ha caiite
Extron: www.extron.com, Homep no katanory - 68-290-01.

Chinese Simplified (#&{#3z)

BE: AR LNZIMFSEERERAPZTRIANERROEKR
R, HREB Bk,

ER: AF MM EERTAFREMMOAAFHRTE
EEMNRIETLIR L) RB.

KTFRINFROREIEE . BEOME. EMEVF HFREE. TER
{EARIESEX NS, BiEE Extron MiE www.extron.com, &1
Extron REMEIE, @RS 68-290-010

Chinese Traditional (2:82/x7)

WARNUNG: Dieses Symbol 4 auf dem Produkt soll den Benutzer
darauf aufmerksam machen, dass im Inneren des Gehéuses
dieses Produktes gefahrliche Spannungen herrschen, die nicht
isoliert sind und die einen elektrischen Schlag verursachen
kénnen.

VORSICHT: Dieses Symbol A auf dem Produkt soll dem Benutzer
in der im Lieferumfang enthaltenen Dokumentation besonders
wichtige Hinweise zur Bedienung und Wartung (Instandhaltung)
geben.

Weitere Informationen Uber die Sicherheitsrichtlinien,
Produkthandhabung, EMI/EMF-Kompatibilitat, Zuganglichkeit und
verwandte Themen finden Sie in den Extron-Richtlinien fir Sicherheit
und Handhabung (Artikelnummer 68-290-01) auf der Extron-Website,
www.extron.com.

Instrucciones de seguridad ® Espariol

ADVERTENCIA: Este simbolo, 4, cuando se utiliza en el
producto, avisa al usuario de la presencia de voltaje peligroso sin
aislar dentro del producto, lo que puede representar un riesgo de
descarga eléctrica.

ATENCION: Este simbolo, A, cuando se utiliza en el producto,
avisa al usuario de la presencia de importantes instrucciones
de uso y mantenimiento recogidas en la documentacion
proporcionada con el equipo.

Para obtener informacién sobre directrices de seguridad, cumplimiento
de normativas, compatibilidad electromagnética, accesibilidad y
temas relacionados, consulte la Guia de cumplimiento de normativas
y seguridad de Extron, referencia 68-290-01, en el sitio Web de Extron,
www.extron.com.

BE ABER LERALER BATREGHS ERRRNTEE
REE BT 2 MR BRERTE -

EB A BES LGRS 2ATIREERE  REMREMNESF
A ERAIRERME (H12) B

BRIRZMEEE S  FARET - EM/EMF 1821 - ZERGEEANA8RE
ERERYFHAMEER » F5%I5E Extron #8uk : www.extron.com s SA742R8
(Extron R2MENERBTFM) - #8I#RSE 68-290-01 ©

Japanese

5 CDRES & HRFBELCRREINTVDIBEE. EFRICE
BEINT VBLBBENAN. REBEOBIRNGDILZE
RUTLET,

ER CORES A PMRBELCRTIENTVDHEGIF. &
BORKHRAEIC THSNTVDEELFRFELR
SF(ER)DIBRICOVTI—T—DFBEIRIIZT D
HDTY,

RE FOTEREREST EMI/EMFESE. ZDhOBSEER(C
DV T IZZAOY DD T T YA hwww.extron.comdkb [Extron
Safety and Regulatory Compliance Guide] (P/N 68-290-01) ZTE<
ZEL,

Korean

i 01712 A, 7L HIZ0 ALZE A2, MiZE2| A=A Lo 2=
X=X p22 9| E18t MR 2 Ol ALK} ZHE 2IE0]
UASE g ct

FO: 01715 A, TH MBS0 ALBE B, T[S BH HZE
KL Ligh U= T2 2% U RA|E4(ZH) KIS
Zaghich

obx Jhol=2tel, A &4, EMIEMF S84, M2, J2|n g
&S0l CHEt REMIEH LIS 2 Extron 2 AFO|E (www.extron.com)2| Extron
OhM ol A E< oM, 68-290-01 ZE S A ZFHAAL.

FCC Class A Notice

This equipment has been tested and found to comply with the limits for a
Class A digital device, pursuant to part 15 of the FCC rules. The Class A
limits provide reasonable protection against harmful interference when

the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment
in a residential area is likely to cause interference; the user must correct the
interference at his own expense.

NOTE: This unit was tested with shielded I/O cables on the
peripheral devices. Shielded cables must be used to ensure
compliance with FCC emissions limits.

For more information on safety guidelines, regulatory compliances,
EMI/EMF compatibility, accessibility, and related topics, see the
“Extron Safety and Regulatory Compliance Guide” on the
Extron website.

Copyright
© 2014 Extron Electronics. All rights reserved

Trademarks
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WallVault, WindoWall, XTP, and XTP Systems

Registered Service Mark®®™ : S3 Service Support Solutions

Trademarks (™)

AAP, AFL - Accu-RATE Frame Lock, ADSP - Advanced Digital Sync Processing, Auto-Image, CableCover,

CDRS - Class D Ripple Suppression, DDSP - Digital Display Sync Processing, DMI - Dynamic Motion
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Conventions Used in this Guide
Notifications

The following are used:

WARNING: Potential risk of severe injury or death.

AVERTISSEMENT: Risque potentiel de blessure grave ou de
mort.

ATTENTION:
e Risk of property damage.
e Risque de dommages matériels.
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NOTE: A note draws attention to important information.

Software Commands

Commands are written in the fonts shown here:
“ARMerge Scene,,Op1 scene 1,1"B51"W"C
[@1] ROVO4 00300 30400 00800 30600 [@2]135[17] [93]

[Esc]fxi] *[xa]* [v35]* [¥37]* [v36] CE 4=
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NOTE: For commands and examples of computer or device
responses mentioned in this guide, the character “@” is used for
the number zero and “O” is the capital letter “0.”

Computer responses and directory paths that do not have variables are
written in the font shown here:

Reply from 208.132.180.48: bytes=32 times=2ms TTL=32

C:\Program Files\Extron

Variables are written in slanted form as shown here:
ping Xxx.Xxxx.xxx.xxx —t
SOH R Data STX Command ETB ETX

Selectable items, such as menu names, menu options, buttons, tabs,
and field names are written in the font shown here:

From the File menu, select New.
Click the OK button.

Specifications Availability

Product specifications are available on the Extron website,
www.extron.com.
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Introduction

WARNING: The fiber optic I/0 boards of the FOX matrix switchers
output continuous invisible light, which may be harmful to the eyes;
use with caution.

Do not look into the fiber optic cable connectors or into the fiber
optic cables themselves.

Plug the attached dust caps into the optical transceivers when the
fiber cable is unplugged.

AVERTISSEMENT : L'appareil émet une lumiére invisible en

continu, a utiliser avec precaution.

Ne regardez pas dans les connecteurs de céble fibre optique sur
le panneau arriere ou dans les cables fibre optique eux-mémes.

Branchez les protections contre la poussiere dans |I'ensemble
émetteur/récepteur lorsque le cable fibre optique est débranché.

This section provides an overview of the Extron FOX Matrix 3200 and
FOX Matrix 7200 and describes their features. Topics that are covered
include:

e About this Guide
e About the FOX Matrix Switchers

About this Guide

NOTE: For more information on any subject in this guide, see the
FOX Matrix 3200 and FOX Matrix 7200 Series User Guide, available
at www.extron.com.

This setup guide helps you easily and quickly set up and configure
your FOX Matrix 3200 and FOX Matrix 7200 switcher. Step by step
instructions show you how to:

¢ [nstall the input and output boards
e Connect the hardware
* Perform basic operations

e Use both the front panel controls and selected Simple Instruction
Set (SIS) commands

* Load and start the Matrix Switchers Control Program

e Connect to the built-in HTML pages, which you can use to operate
the switcher

FOX Matrix 3200 and FOX Matrix 7200 ¢ Introduction 1



About the FOX Matrix Switchers

FOX 3G HD-SDI
Singlemode

The FOX Matrix Switchers (see figure 1 for a FOX Matrix 3200 example)
are configurable matrix switchers that distribute optical signals. Fiber
optic I/0O boards route signals that are compatible with all Extron

FOX 500, FOXBOX, FOX, FOX 2G, and FOX HD-SDI fiber optic product
lines. 3G/HD-SDI/SDI/ I/0O boards route 3G, high definition serial digital
interface (HD-SDI), and serial digital interface (SDI) signals. The matrix
switcher routes any input signal to any combination of outputs. An
optical input can be tied to optical outputs, 3G/HD-SDI SDI outputs,

or both and an 3G/HD-SDI SDI input can be tied to 3G/HD-SDI/SDI
outputs, optical outputs, or both. The matrix switcher can route multiple
input/output configurations simultaneously.

507100

FOX 3G HD-SDI
Multimode

X 3GHD-SDI
Singlemode

FOX Matrix 3200

® Singlemode
1/0 Board
@ Multimode
1/0 Board
SDI/HD-SDI
1/0 Board

Singlemode

Multimode

SDI/HD-SDI

NOTE: In this figure, the FOX 3G HD-SDI units
are set to bidirectional transceiver mode.

Figure 1. Typical FOX Matrix 3200 application

The Extron proprietary fiber optic signal, generated by Extron fiber
optic transmitters, can include video, stereo audio, and transmitter-
to-receiver RS-232 serial communications. The video component of
the signal can be RGB video, Digital Visual Interface (DVI) video, HDMI
video, 3G/HD-SDI/SDI video, or low resolution video, depending on the
transmitter and receiver.

The matrix switcher can be remotely controlled via its Ethernet LAN port

or either of two serial ports, one on the rear panel and one on the front
panel, using either the Windows-based Extron Matrix Switchers Control
Program or the SIS.

2 FOX Matrix 3200 and FOX Matrix 7200 ¢ Introduction

NOTES:

e Compatible optical signals are digital signals from 270 Mbs
through 4.25 Gbps that are sent and received via fiber optic
small form factor pluggable (SFP) modules.

e The FOX transmitter-to-receiver communications, including the
serial link, occupy one matrix switcher input and output. This
matrix switcher can also support the FOX return (receiver-to-
transmitter) serial communications, but returning this signal
stream to the transmitter occupies a separate matrix switcher
input and output.

The switcher has two internal, hot-swappable 100 VAC to 240 VAC,
50-60 Hz, 175-watt (FOX Matrix 3200) or 180-watt (FOX Matrix 7200)
power supplies that provide worldwide power compatibility and reliability.

Configurability and Transmission modes

The FOX Matrix Switchers are assembled from individual input/output
(1/0) boards. The switcher can include up to four (FOX Matrix 3200) or
nine (FOX Matrix 7200) I/0O boards, each of which supports 8 inputs by
8 outputs. The four types of I/O boards are:

¢ Singlemode fiber optic 8x8 I/0 board
e Multimode fiber optic 8x8 I/0 board

¢ Singlemode pathological fiber optic 8x8 1/0 board. This board
addresses the compatibility issues of passing pathological signals
generated from 3G HD-SDI, HD-SDI, and SDI signals over fiber optic
systems

e 3G HD-SDI, HD-SDI, and SDI 8x8 I/0 board

NOTE: As listed above, three versions of the fiber optic I1/0 boards
are documented in this manual. They are categorized by the type
of fiber optic cable, multimode or singlemode, which defines the
effective range of transmission:

e Singlemode — Very long distance, up to 30 km (18.75 miles)

e Multimode — Long distance, up to 300 m (984 feet)

By adding or removing I/O boards, you can expand and contract the FOX
Matrix Switchers from an 8-input by 8-output matrix to up to either:

* FOX Matrix 3200 — A 32-input by 32-output matrix
e FOX Matrix 7200 — A 72-input by 72-output matrix

NOTE: On a fiber optic I/0O board as delivered from Extron, all
transceiver modules are configured the same: either all multimode
or all singlemode. You can mix multimode and singlemode fiber
optic I/0O boards in a FOX matrix switcher, but you must ensure
that you connect the proper transmission mode fiber cables to the

board.

FOX Matrix 3200 and FOX Matrix 7200 ¢ Introduction 3
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FOX Matrix 3200 and FOX Matrix 7200 ¢ Introduction

Installation

This section describes installation of the FOX matrix switchers, including
connections and features. Topics that are covered include:

e Rear Panel

*  Front Panel

Rear Panel

A Note on 1/0 Boards

As shown in figure 2, each I/O board is identified by the input and output
numbers supported by the board position. The transceiver modules on
the 1/0 boards are identified as A through H.

141 1#2 143 1#4 1#5
Output and Input O#;]_ / O#‘Z / O#‘g / O#‘4 / O#‘s / O#‘G )

Extron j@D Luﬂ\jgﬁ ()‘H\gﬁ v)b\?gﬁ O% Extron )EV?WZ/W DM S!lost)l o
om W om om . m w20

17-24

pO#9\ o#0 | o#11 | om2 | o#13\ O#l4 /
#9 #10 11 #12 _1#13

b @@@@@@@@

MUT RATE le INPUTS

T AETETE A

1#25 1#27 1#29 1#31 O#25
L tion A Location H Location A

Figure 2. Arrangement of Inputs and Outputs on the I/0 Boards

Slot 4
(25-32)

25 22

The board position designators, printed beside the fans, correspond to
the input and output numbers served by that position (1 - 8, 9 - 16, and
SO on).

The location designators, A through H, correspond to the transceiver
modules, numbered from left to right, each of which includes an input
and an output.

See figure 2. The input and output numbers supported by the I/O board
in slot 2 (location 9 - 16) are as follows: A=9,B=10,C=11,D =12,
E=13,F=14,G=15,and H = 16.

ATTENTION:

e Turn off power to the input and output devices, and disconnect
their power cords before making connections.

e Débranchez le produit et les autres appareils.

FOX Matrix 3200 and FOX Matrix 7200 e Installation 5



WARNING: This unit outputs continuous invisible light, which
may be harmful to the eyes; use with caution. For additional
safety, plug the attached dust caps into the optical transceivers
when the fiber cable is unplugged.

AVERTISSEMENT : L'appareil émet une lumiére invisible
en continu, a utiliser avec precaution. Branchez les protections
contre la poussiére dans I'ensemble émetteur/récepteur lorsque
le cable fibre optique est débranché.
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FOX Matrix 7200 Switcher Rear Panel

HIF

Figure 3.

@ Fiber optic boards with connectors and LEDs (see page 7).

© 3G HD-SDI, HDI-SDI, and SDI boards with connectors (see page 8).

©® Remote port (see page 8).

@ Ethernet port (LAN connector) (see page 8).
@ Reset button and LED (see page 8).

@ Switch Reference connectors (see page 8).

©® Power connectors (see page 9).

FOX Matrix 3200 and FOX Matrix 7200 e Installation

Extron

“ANAHEIM, CA

Extron

Extron
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00000, 000000
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@09 00
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Extron Extron

Figure 4. FOX Matrix 3200 Switcher Rear Panel

@ Power Supply indicator LEDs (see page 9).

© Replaceable fans (see Removing and
Installing a Fan Module on page 31 to

OPTICAL
replace the fan).

—1 2r=—
4

Making Connections

@ Fiber optic boards with connectors and
LEDs — Unit

itti * OPTIONAL FOR
Transmitting QPTIONAL FO

NOTES:

e Ensure that you use the proper
fiber cable for your 1/0 board.
Typically, singlemode fiber has a
yellow jacket and multimode cable
has an orange or cyan jacket.

e The FOX matrix switcher uses one
connector on the block as an input
and the second connector on the 23
same block as a separate output.

FOX Matrix
Switcher [J
® Input connector — Connect a fiber
optic cable between each Input LC
connector and a FOX 500 Tx or any
other compatible Extron FOX device.

NOTE: Or, for the serial return
(receiver-to-transmitter) function, o
connect the far end to the Optical 2 Recelylng
connector on a FOX Rx receiver. Unit

OPTICAL
*

Input LED — See Fiber optic I/0
board LED indications on page 9.

* OPTIONAL FOR
RETURN DATA

FOX Matrix 3200 and FOX Matrix 7200 e Installation 7



@ Output connector — Connect a fiber optic cable between each
output LC connector and a FOX 500 Rx or any other compatible
Extron FOX device.

NOTE: Or, for the serial return (receiver-to-transmitter)
function, connect the far end to the Optical 2 connector on a
FOX Tx transmitter.

Output LED — See Fiber optic I/0 board LED indications on
the next page.

© SDI/HDI-SDI boards with BNC connectors —

@ Multi-rate SDI Input connectors — Connect HD-SDI, SDI, or
3G-SDI video inputs to these BNC connectors.

@ Multi-rate SDI Output connectors — Connect digital displays to
these BNC connectors.

Remote port — If desired, connect a control system or computer to
the rear panel Remote RS-232/RS-422 port.

Pin| RS-232/Function [|RS-422 Function

— |Not used Rx+ |Receive (+)
— |Notused || Tx+ |Transmit (+)
— |Not used —

1 — |Not used — |Not used
2 Tx |Transmit Tx— |Transmit (=)
5 1 3| Rx |Receive Rx— |Receive (-)

@ @ 4| — |Notused | — |Notused

5 Gnd |Ground Gnd |Ground

6 — |Not used — |Not used

7

8

9

Not used

Figure 5. Audio Output Connector Wiring

LAN port — If desired, connect a network WAN or LAN hub, a
control system, or a computer to the Ethernet RJ-45 port.
Network connection — Wire as a patch (straight) cable.

Computer or control system connection — Wire the interface cable
as a crossover cable.

I NOTE: The factory default IP address is 192.168.254.254.

Reset button — Initiates four levels of reset of the matrix switcher.
For different reset levels, press and hold the recessed button while
the switcher is running or while you power up the switcher.

See the FOX 3200 and 7200 Series User Guide, available at
www.extron.com.

Switch Reference connectors (affect SDI / HD-SDI inputs and
outputs only) — Connect an external sync signal to this BNC
connector to genlock the video signal in broadcast or other sync-
critical applications.

FOX Matrix 3200 and FOX Matrix 7200 e Installation

©® Power connectors — Plug the switcher into two grounded AC

sources.

NOTE:
either an uninterruptible power source or to a power source that
is completely independent from the primary power source.

For reliability, connect the Redundant power cord to

® Primary and Redundant power supply indicator LEDs —

Green — Indicates that the associated power supply is operating
within normal tolerances.

Red — Indicates that the associated power supply is operating
outside the normal tolerances or has failed. See Removing and
Installing a Power Supply Module on page 29 to replace the power

supply.

Fiber optic I/0 board LED indications

On the fiber optic I/O boards, the input and output LEDs on the
transceivers provide useful indications of the status of the lasers and the
reclocking function (see the table below).

our@Q | O
=
Output LED | Input LED
Definition indication indication Definition
Reclocked at 4.25 Gbps On On Reclocked at 4.25 Gbps
Not reclocked, laser off, Off Off Not reclocked or no
or no signal signal
Non-4G signal present or Fast blink Fast blink Non-4G signal present or
not reclocked not reclocked
Not reclocked, laser on or Slow blink Slow blink N/A
no signal

NOTE: If reclocking is set to bypass, the Output LED is always on.

FOX Matrix 3200 and FOX Matrix 7200 e Installation
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Front Panel

10

® Elwmwo
REDUNOANT O
e ®)
FOX 4G MATRIX 3200 @
EER OPTIC DIGTAL MATRIX SWITCHER

© @

@ Configuration port — If desired, connect a control system or

computer to the front panel Configuration (RS-232) port. Use an
optional 9-pin D to 2.5 mm mini jack TRS RS-232 cable.

© Primary and Redundant Power Supply LEDs —

Green — Indicates that the associated power supply is operating
within normal tolerances.

Red — Indicates that the associated power supply is operating
outside the normal tolerances or has failed (see Removing and
Installing a Power Supply Module on page 29 to replace the power
supply).

FOX Matrix 3200 and FOX Matrix 7200 e Installation

Front Panel Operations

This section describes simple matrix switcher operation from the front
panel. Topics that are covered include:

Creating a Tie
Viewing Ties (and Muting Outputs)
Saving or Recalling a Preset

Locking the Front Panel (Executive Mode)

Creating a Tie

A "tie" is an input-to-output connection.

A "set of ties" is an input tied to two or more outputs. (An output can
never be tied to more than one input.)

A "configuration" is one or more ties, one or more sets of ties, or a
combination.

1.

Press and release the Esc button to clear any input button, output
button, or control button indicators that may be lit.

Press and release the desired input button.

The button lights to indicate the selection.

5

Press and release the desired output buttons.

The output buttons blink to indicate the potential ties.
(L} (L} (L] (L}

TN TS Tiav IR

The Enter button blinks to indicate
the need to confirm the change.

= = = ENTER

Ty

7y

Press and release the Enter button. The tie is created and all button
indicators turn off.

FOX Matrix 3200 and FOX Matrix 7200 ¢ Front Panel Operations
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Viewing Ties (and Muting Outputs)

1. Press the View button. Output buttons light for outputs that have no
ties established.

NOTE: If an output button blinks, that output is muted. To

toggle mute on and off, press and hold the output button for
2 seconds.

Press an input button. The buttons for all tied outputs light.

Press an output button. The buttons for the tied input and all tied
outputs light.

4. Press the View button again to exit View mode. All input and output
buttons return to an unlit state.

Saving or Recalling a Preset

A "preset" is a configuration that has been stored.

1. Save a preset — Press and hold the Preset button until it flashes.

(]

Save a 2 seconds
p I’eset PRESET

PRESET

Y
7y

7N
Press and hold. Preset button blinks.

Recall a preset — Press and release the Preset button.

Recall a
preset PRESET »{PRESET

Press and release. The Preset button lights.

All input and output buttons with assigned presets light red.
When a preset is saved, the configuration data at
assigned preset locations will be overwritten.

1|2)3|4]5]6{(15]16

'\

2. Press and release the desired input or output button.

this preset is selected to save or recall.
A

The button blinks red to indicate that
A /1

- The Enter button blinks
1 = red to indicate the need to
RN v activate the save or recall.

ENTER

AN

Y

I

3. Press and release the Enter button.

12 FOX Matrix 3200 and FOX Matrix 7200 ¢ Front Panel Operations

Locking the Front Panel (Executive Mode)

To toggle the lock on and off, simultaneously press and hold the Enter
button and the Esc button for approximately 2 seconds..

Press and hold the Enter and
Esc buttons simultaneously to
toggle executive mode on or off.

I_coveor L]

ENTER ESC 2 SeCOndS PRESET{ VIEW
A v

The Preset and View buttons
blink twice to indicate the
mode change.

Release the buttons.

FOX Matrix 3200 and FOX Matrix 7200 ¢ Front Panel Operations 13
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Remote Control

This section describes using the remote control features of the
FOX matrix switchers to control the devices. Topics that are covered
include:

® Selected SIS Commands
e Matrix Switchers Control Program
e Built-in HTML Pages

Selected SIS Commands

You can use Simple Instruction Set (SIS) commands for operation and
configuration of the switchers. You can run these commands from a PC
connected to the rear panel Remote RS-232/RS-422 port (item @ on
page 8), LAN port (item @ on page 8),or front panel configuration port
(item @ on page 10) on the switcher.

NOTE: The table that begins on the next page is a partial
list of SIS commands. For a complete listing, see the

FOX Matrix 3200 and FOX Matrix 7200 Series User Guide.

FOX Matrix 3200 and FOX Matrix 7200 ¢ Remote Control 15
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Command and Response Table for SIS Commands

Command

ASCIl Command
(Host to Unit)

Response
(Unit to Host)

Additional Description

Create ties

NOTES: ¢ Commands can be entered back-to-back in a string, with no spaces. For example: 1*1!02*028003*0@3%4*24!.
e The matrix switchers support 1-, 2-, and 3-digit numeric entries (1*1!, 32*@28&, or 393*@3B3%).
e The ! tie command, the & tie command, and the % tie command can be used interchangeably, as can the ! read tie command, the &

tie command, and the % read tie command.

Tie input [X1] to output [x2] xi*x2! Outx2eInXijeAll <! Tie input X1] to output [x2].
Example (see Note, above): 1*3! Out@3eIngieAlled Tie input 1 to output 3.
Tie input X1] to output [x2| xa]*x2]& Out[x2e InX1]* RGB! Tie input X1] to output [x2].
Example (see Note, above): 10*4& Out@4eInigeRGB< Tie input 10 to output 4.
Tie input [X] to output [X2], [a]*[x2ks Outx2eInXilevide! Tie input [X1] to output [x2].
Example (see Note, above): 7*5% Out@5eIn@7eVided Tie input 7 to output 5.
Read output tie x2& Input [X1] is tied to output X2.
Read output tie x2ks il Input X1] is tied to output [X2].
Read output tie x2)! i« Input X1] is tied to output [X2].
NOTE: e =Space
[x1] = Input number @@ — maximum number of inputs for your configuration (00 = untied)
[x2) = Output number @1 — maximum number of outputs for your configuration
Command ASCII Command Response Additional Description

(Host to Unit)

(Unit to Host)

Channel mutes
Channel mute

Channel unmute

Read channel mute

Global channel mute
Global channel unmute
View output mutes

x2*1B
[x2]*oB
[x2B

1*B

0*B
[EsclvM<+—

th@*1<—'
Vmtx2* g«
X3«
vmt1ed
vmtg«d

a3l ... K3+

Mute output [X2] (no signal is output, light output remains active).
Unmute output [X2] (signal is output).

1 = mute on, @ = mute off.

Mute all light outputs.

Unmute all light outputs.

Each [X3] response is the mute status of an output, starting from
output 1. n = the maximum of outputs for your configuration.

Save and recall presets

NOTE:

If you try to recall a preset that is not saved, the matrix switcher responds with the error code E11.

Save current configuration as  [x4], Sprixal«d Command character is a comma.
a global preset
Example: 9, Spro9g«! Save current ties as preset 9.
Recall a global preset [xa]. Rprixa«! Command character is a period.
Example: 5. Rpros<! Recall preset 5 to become the current configuration.
Front panel lock (executive mode)
Lock front panel functions 1X Exeled
Unlock front panel functions [4).4 Exeged
View lock status X (x5}t

NOTE:

[x2] = Output number
[x3] = Mute

= Global preset number

[x5] = Lock

@1 — maximum number of outputs for your configuration
1 = mute on, @ = mute off

g1 -64
@ = off (unlocked)

1 = on (locked)
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Command ASCIl Command
(Host to Unit)

Response Additional Description
(Unit to Host)

Information requests

Information request I
Request part number N
Request part number and *N

board configuration

VixeX[x7]e AlxelX[x7]e S[xe] [xaP... [xaf+!

shows the number of available inputs and outputs for

this configuration.

has no meaning for this product.

S[xa]'x8P...[x8] shows the board type installed in each slot.

nis 4 (FOX Matrix 3200) or 9 (FOX Matrix 7200).
[xa].[xa]'[xapxa][xal {xalxalixa] xalxa]«

4 (FOX Matrix 3200) or 9 (FOX Matrix 7200) [x8s.

Query firmware version Q [x10]«!
Example: Q 1.23« The factory-installed firmware version is 1.23 (sample value only).
NOTE: = Inputs Total number of inputs for this switcher
= Outputs Total number of outputs for this switcher
= Board installed @ = No board installed
1 = 8x8 multimode board 3 = 3G/HD-SDI/SDI board
2 = 8x8 singlemode board X = Unknown board or mix of transceivers installed
= Part number 6@-nnnn-nn

= Firmware version number to second decimal place (x.xx)

Command ASCII Command Response Additional Description
(Host to Unit) (Unit to Host)
IP setup
Set IP address [Esc[XT1]CI +— Ipijxiijed
Read IP address [EsclCI < Y10]
Set DHCP on or off [Esc]x12]DH<+— Idhjxi2led
Read DHCP on/off status [Esc]DH<— X12)
Set verbose mode [Esc]Yi3/CV+ Vrblyi3j+!
Read verbose mode [EsclCV<— [vi3}e
Configure current port timeout  [Esc|@*[Y14]TC <= Ptig*[yialed
Read current port timeout [EscloTC+ Y14
Configure global IP port timeout [Esc]1 *[y14]TC+= Ptii1*[yia}ed
Read global IP port timeout [Esc]1TC+ vig}e!
NOTE: [Xii] = IP address nnn.nnn.nnn.nnn
[x12] = DHCP @ =off, 1 =on
[x13] = Verbose mode @ = clear or none (default for Telnet connection)

1 = verbose mode (default for RS-232/RS-422 connection)
2 = tagged responses for queries
3 = verbose mode and tagged for queries
= Port timeout interval 1 (= 10 seconds) — 65033 (default is 3@ = 300 seconds = 5 minutes)




Matrix Switchers Control Program

Another way to operate the switcher is via the Matrix Switchers Control
Program, which runs on computers that use the Windows® operating
system This program is available on the Extron website. You can run this
program from a PC connected to the rear panel Remote RS-232/RS-422
port (item @ on page 8), LAN port (item @ on page 8), or front panel
configuration port (item @ on page 10) on the switcher.

NOTE: For details on operating the program, see the “Matrix
Software” section in the FOX Matrix 3200 and FOX Matrix 7200 User
Guide.

Installing the Program

The Matrix Switchers Control Program is available on the Extron website.

Download and install all programs as follows:
1. Visit www.extron.com and click the Download tab.

0@
,

Click the Software link.

Select the desired software to download and click Download.

TIP: Jump to the nearest page of downloads by clicking the
desired filtering letter.

Matrix Switchers 79-520-01 83 Sep. 16, 2013 15_09 = Download
Control software for most Extron matrix switchers, including MAV

Series (except MAV 62), MAV Plus, Matrix 50, CrossPoint, CrossPoint

The Download Center dialog box appears (see figure 6, on the next
page).

20 FOX Matrix 3200 and FOX Matrix 7200 ¢ Remote Control
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Figure 6. Download Center Dialog Box

4. Enter the requested personal information.

I TIP: Click Remember Me to eliminate step 4 in future downloads.

5. Click Download to copy the software or firmware to your computer.

The download warns you about downloads and asks you to confirm

it.

Do you want to run or save mtx200.exe (537 KE! from media.extron.com?

'j;" This type of file could harm your computer. R(w; Save - Cancel

Cick Run to confirm that you want to run the installation.

Follow the on-screen instructions. The installation program creates
the necessary directories and folders and installs the programs.

LAN port Connection

The first time you connect your PC to the switcher via the LAN port,
you may need to change the default settings (IP address, subnet
mask, and [optional] administrator name and password) on the
controller (see the "Configuring for Network Communication" in the
FOX Matrix 3200 and FOX Matrix 7200 User Guide.

Starting the Program

1. Click Start > Programs > Extron Electronics > Matrix
Switchers > MATRIX Switcher + Control Pgm.

The Comm Port Selection window appears.

FOX Matrix 3200 and FOX Matrix 7200 ¢ Remote Control
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2. Choose the comm (serial) port that is connected to the switcher or IP
[LAN].

NOTE: For a comm port, check the 9600 baud
baud rate displayed in the Comm Port ;gfgg ';gzg

Selection window. If you need to change 115200 baud
the baud rate, click the Baud button and
double-click the desired baud rate.

3. Click OK.

If you selected a serial port in step 2, the Matrix Switchers Control
Program is ready for operation.

4. If you selected IP [LAN] in step 2, the IP Connection window
appears.

a. Examine the Matrix IP Address field, which displays the last
Matrix IP address entered.

If necessary, enter the correct IP address in the field.

NOTE: 192.168.254.254 is the factory-specified default

value for this field.

b. If the switcher is password-protected, enter the appropriate
administrator or user password in the Password field.

c. Click connect. The Matrix Switchers Control Program is
ready for operation.

FOX Matrix 3200 and FOX Matrix 7200 ¢ Remote Control

Built-in HTML Pages

Another way to configure and operate the switcher is via its factory-
installed HTML pages, which are always available and cannot be erased
or overwritten. The HTML pages that are pre-loaded on the switcher
are accessible through its LAN port (item @ on page 8), connected

via a LAN or WAN, using a web browser such as Microsoft® Internet
Explorer®.

Configuring for Network Communication

The first time you connect a PC to a switcher via its LAN port, you

may need to temporarily change the IP settings of the PC in order to
communicate with the controller. Then you must change the default
settings of the controller (IP address, subnet mask, and [optional]
administrator name and password) in order to use the unit on an intranet
(LAN) or on the Internet. After you have set up the FOX matrix switcher
for network communication, you can reset the PC to its original network
configuration.

NOTE: The computer and the switcher must both be connected
to the same subnet on a LAN (using a straight-through cable).
Alternatively, you can use a crossover Ethernet cable to connect the
controller directly to the computer.

Use the ARP command to configure the IP address as follows:

1. Obtain a valid IP address for the FOX matrix switcher from the
network administrator.

2. Obtain the MAC address (UID number) of the switcher from the
label on its rear panel. The MAC address should have this format:
00-05-A6-XX-XX-XX.

3. If the switcher has never been configured and is still set for factory
defaults, go to step 4. If not, perform a Mode 4 system reset. For
detailed information on reset modes, refer to “Reset Operations” in
the FOX Matrix 3200 and FOX Matrix 7200 User Guide.

NOTE: The switcher must be configured with the factory
default IP address (192.168.254.254) before the ARP command
is executed, as described below.

4. Atthe PC, access the MS-DOS® command prompt, then enter the

arp —s command. Type in the desired new IP address for the unit
(obtained in step 1) and the MAC address of the unit (from the rear
panel of the unit). For example:

arp —s 10.13.197.7 90-05-A6-03-69-B@ and then press <Enter>.

After receiving the arp -s command, the controller changes to
the new address and starts responding to the ping requests, as
described in step 5.
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NOTE: You must ping the FOX matrix switcher as shown in
step 5 for the IP address change to take place. The response
should show the new IP address, as shown in the following
figure.

5. Execute a ping command by entering “ping” followed by a space and
the new IP address at the command prompt. For example:
ping 10.13.197.7

Pi ngi ng 10.13.197.7 with 32 bytes of data:

Reply from 10.13.197.7: bytes=32 tinme<lOns TTL=128
Reply from 10.13.197.7: bytes=32 tinme<lOns TTL=128
Reply from 10.13.197.7: bytes=32 tinme<lOns TTL=128
Reply from 10.13.197.7: bytes=32 tinme<lOns TTL=128

Ping statistics for 10.13.197.7:
Packets: Sent = 4, Received = 4, Lost = 0 (0% oss),
Approximate round trip tines in mlli-seconds:

M ni mum = Onms, Maxi mum = Onms, Average = Ons

- /

/"C:\>ping 10.13.197.7 N

NOTE: You can reconnect using either Telnet or a Web browser
to verify that the update was successful.

6. After verifying that the IP address change was successful, enter and
issue the “arp —d” command at the DOS prompt. For example:

arp —d 18.13.197.7 removes 10.13.197.7 from the ARP table
or
arp —d* removes all static IP addresses from the ARP table.

Loading the Start-up Page

NOTES:

e |f your Ethernet connection to the matrix switcher is unstable,
try turning off the proxy server in your Web browser. In
Microsoft Internet Explorer, click Tools > Internet Options >
Connections > LAN Settings, uncheck the Use a proxy
server... box, and then click OK.

* For details on operating the switcher via HTML pages, refer
to the "HTML Operation" section in the FOX Matrix 3200 and

FOX Matrix 7200 User Guide.

1. Start the Web browser program.
2. Click in the Address field.
3. Enter the Matrix IP address in the Address field.

NOTE: 192.168.254.254 is the factory-specified default value
for this field.

FOX Matrix 3200 and FOX Matrix 7200 ¢ Remote Control

4. Press the keyboard <Enter> key. The switcher checks to see if it is
password-protected.

If the switcher is not password-protected, it checks and
downloads the HTML start-up page. The switcher is ready for
operation via HTML remote control.

If the switcher is password-protected, it downloads the Enter
Network Password page.

NOTE: A User name entry is not required.

5. Enter the appropriate administrator or user password in the Password
field and click OK.

The switcher downloads the HTML start-up page (see figure 7). The
switcher is ready for operation via HTML remote control.

Figure 7. HTML Startup Page
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Maintenance and
Modifications

This section describes repairing and reconfiguring the FOX matrix
switchers by replacing components. Topics that are covered include:

Removing and Installing a Board or Blank Panel
Removing and Installing a Power Supply Module

Removing and Installing a Fan Module

Removing and Installing a Board or Blank Panel

Circuit boards can be added or removed to increase or decrease the 1/0
configuration (size) of the switcher.

WARNING: The fiber optic I/0 boards of the FOX matrix switchers
output continuous invisible light, which may be harmful to the eyes;
use with caution.

Do not look into the fiber optic cable connectors or into the fiber
optic cables themselves.

Plug the attached dust caps into the optical transceivers when the
fiber cable is unplugged.

AVERTISSEMENT: L'appareil émet une lumiére invisible en

continu, a utiliser avec precaution.

Ne regardez pas dans les connecteurs de cable fibre optique sur
le panneau arriere ou dans les cables fibre optique eux-mémes.

Branchez les protections contre la poussiére dans |'ensemble
émetteur/récepteur lorsque le céable fibre optique est débranché.

NOTES:

e On afiber optic I/0 board as delivered from Extron, all transceiver
modules are configured the same: either all multimode or all
singlemode. You can mix multimode and singlemode fiber
optic I/O boards in a FOX matrix switcher, but ensure that you
connect the proper transmission mode fiber cables to the board.

e Typically, singlemode fiber has a yellow jacket and multimode
cable has an orange or cyan jacket.

e For proper cooling and air flow, boards or blank panels should
be installed in all locations during normal switcher operations.

e See A Note on I/0 Boards on page 5 to understand the
different arrangement of connectors on the I/O boards.

e The FOX Matrix Switcher components that are user-replaceable
are hot-swappable. You do not need to power down the
switcher to remove or replace a component.
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Remove and replace and I/O board or blank panel as follows:
1. For a board, disconnect any connected cables.

2. Rotate the left and right knurled knobs to completely loosen the
captive screws.

3. Gently pull on the knurled knobs/captive screws to loosen the board
or panel from the backplane.

4. Slide the board or panel out of the chassis (below).

ATTENTION:

e Do not touch the electronic components or the connectors
on the backplane or on the circuit boards without being
electrically grounded. Handle circuit boards by their edges
only. Electrostatic discharge can damage circuits, even if
you cannot feel, see, or hear it.

¢ Ne pas toucher les composants électroniques ou les
connecteurs sur la carte meére ou sur les circuits imprimés
sans étre électriquement relié a la terre. Manipuler les
circuits imprimés en les tenant seulement par leurs bords.
Les décharges électrostatiques (ESD) peuvent endommager
I'équipement, méme si vous ne pouvez pas le sentir, le voir
ou |'entendre.

Align with
Plastic Guides

Knurled Knobs

5. Place the removed board on an anti-static surface or in an anti-static
container.

6. For an I/0 board, orient the board to be installed so that transceiver
module A (fiber board) or input BNC A (3G/HD-SDI/SDI board) is on
the left and transceiver module or output BNC H is on the right.

7. For an I/0 board, align the board with the left and right chassis
guides.

FOX Matrix 3200 and FOX Matrix 7200 ¢ Maintenance and Modifications

8. Gently slide the board or blank panel into the enclosure. For an I/0
board, slide the board toward the front panel until it meets resistance.

9. Gently seat the board or panel in the backplane.

10. Use a screwdriver to tighten the left and right knurled knob captive
screws to lock the board or panel in place.

Removing and Installing a Power Supply Module

The two power supply modules (primary power supply and redundant
power supply) are identical. Each power supply module has a 2-color
LED, visible on the rear panel, that indicates the status of the power
supply outputs. If the LED is lit green, the power supply is operating
normally. If the LED is lit red, the supply has failed and should be
replaced at the earliest opportunity. LEDs with identical meaning are also
on the front panel.

ATTENTION:

e This unit uses double pole/neutral fusing. Do not operate the
equipment with only one power supply cord connected.

e (Cette unité utilise double poles/fusion neutre. N'utilisez
pas |'équipement avec seulement un cordon d'alimentation
connecté.

NOTE: Power supply modules are not interchangeable between
models.

1. Rotate the left and right knurled knobs to completely loosen the
captive screws.

2. Gently pull on the handle to loosen the power supply from the
backplane.

Slide the power supply out of the chassis.

Orient the power supply module to be installed with the LED to the
right.

5. Align the flanges on the power supply module with the left and right
power supply guides (see the next page).

6. Gently slide the power supply module into the enclosure until the
power supply meets resistance.
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Removing and Installing a Fan Module

The FOX Matrix 3200 has a single fan module. The FOX Matrix 7200
has two identical fan modules. If a fan fails, it should be replaced at the
earliest opportunity.

1. Rotate the top and bottom knurled knobs to completely loosen the
captive screws.

Gently pull on the screws to loosen the fan from the backplane.
Slide the fan out of the chassis.

Orient the fan to be installed so that the printing on the back of the
panel is right-side up.

Align the flanges on the fan with the top and bottom fan guides.

Align with

Plastic Guides Gently slide the fan into the enclosure until the fan meets resistance.

Gently seat the fan in the backplane.

© N o O

Use a screwdriver to tighten the top and bottom knurled knob captive
screws to lock the fan in place.

Power
LED

Gently seat the power supply in the backplane.

8. Use a screwdriver to tighten the left and right knurled knob captive
screws to lock the power supply in place.

Align with
Plastic Guides
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Extron Warranty

Extron Electronics warrants this product against defects in materials and workmanship
for a period of three years from the date of purchase. In the event of malfunction during
the warranty period attributable directly to faulty workmanship and/or materials, Extron
Electronics will, at its option, repair or replace said products or components, to whatever
extent it shall deem necessary to restore said product to proper operating condition,
provided that it is returned within the warranty period, with proof of purchase and
description of malfunction to:

USA, Canada, South America,

and Central America: Japan:
Extron Electronics Extron Electronics, Japan
1001 East Ball Road Kyodo Building, 16 Ichibancho
Anaheim, CA 92805 Chiyoda-ku, Tokyo 102-0082
U.S.A. Japan
Europe and Africa: China:
Extron Europe Extron China
Hanzeboulevard 10 686 Ronghua Road
3825 PH Amersfoort Songjiang District
The Netherlands Shanghai 201611

China
Asia: Middle East:
Extron Asia Extron Middle East
135 Joo Seng Road, #04-01 Dubai Airport Free Zone
PM Industrial Bldg. F12, PO Box 293666
Singapore 368363 United Arab Emirates, Dubai
Singapore

This Limited Warranty does not apply if the fault has been caused by misuse, improper
handling care, electrical or mechanical abuse, abnormal operating conditions, or if
modifications were made to the product that were not authorized by Extron.

NOTE: If a product is defective, please call Extron and ask for an application
engineer to receive an RA (return authorization) number. This will begin the repair

process.
USA: 714.491.1500 or 800.633-9876 Europe: 31.33.453.4040
Asia: 65.6383.4400 Japan: 81.3.3511.7655

Units must be returned insured, with shipping charges prepaid. If not insured, you assume
the risk of loss or damage during shipment. Returned units must include the serial number
and a description of the problem, as well as the name of the person to contact in case
there are any questions.

Extron Electronics makes no further warranties either expressed or implied with respect to
the product and its quality, performance, merchantability, or fitness for any particular use.
In no event will Extron Electronics be liable for direct, indirect, or consequential damages
resulting from any defect in this product even if Extron Electronics has been advised of
such damage.

Please note that laws vary from state to state and country to country, and that some
provisions of this warranty may not apply to you.



Extron USA Headquarters

+800.633.9876 (Inside USA/Canada Only)

Extron USA - West
+1.714.491.1500
+1.714.491.1517 FAX

Extron USA - East
+1.919.850.1000
+1.919.850.1001 FAX

Extron Europe

+800.3987.6673 (Inside Europe Only)
+31.33.453.4040

+31.33.453.4050 FAX

Extron India

1800.3070.3777 (Inside India Only)
+91-80 3055.3777

+91 80 3055 3737 FAX

Extron Japan
+81.3.3511.7655
+81.3.3511.7656 FAX

Extron Asia
+800.7339.8766
Inside Asia Only

+65.6383.4400
+65.6383.4664 FAX

Extron Middle East
+971.4.2991800
+971.4.2991880 FAX

Extron Korea
+82.2.3444.1571
+82.2.3444.1575 FAX

Extron China
+4000.EXTRON
+4000.398766
Inside China Only

+86.21.3760.1568
+86.21.3760.1566 FAX
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